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Computer Technology 

Assignment 1 
Microsoft Excel 2007 

1. Go to Student Common/Computer Technology/Spreadsheets/Assignment 1. This will open up a Word Document. 

Go to the website indicated on the sheet: http://www.usd.edu/trio/tut/excel/index.html. This is a basic tutorial on 

Excel and on Excel vocabulary, which will be what is on the final at the end of the semester.  

2.  Print a copy of Assignment 1, then answer the questions on it as you go through the tutorial.   

3. At the end of the tutorial there will be a quiz. Take the quiz, and print the results.  

4. Staple your quiz to the tutorial and turn into the basket when finished. 

 
Computer Technology 

Assignment 2 
Microsoft Excel 2007 

 
1. Open Student Common/Computer Technology/Spreadsheets/Assignment 2. Here you have the 

nutritional information for some of the items on the menus of various fast-food restaurants.  

2. First we are going to move the contents in Cell A2 into A1. Click on cell A2. Place your cursor on the 

EDGE of the cell so that it turns into a four-sided arrow. Then drag it up one cell, into cell A1. 

3. Now lets make column A wider so we can see the contents easier. Place your cursor 

between the A and B so that it turns into a two-sided arrow. Double click. 

a. The column should automatically re-size to the length of the longest word in that column. 

4. Highlight Row 1. Right click on the area you have highlighted and choose Insert from the menu. 

a. Lƴ ǘƘŜ ƴŜǿ !мΣ ǘȅǇŜ ǘƘŜ ǘƛǘƭŜ άbǳǘǊƛǘƛƻƴŀƭ CŀŎǘǎέ 

b. Highlight cells A1-F1 and press  

c. Change the font size to 18. 

d. Change the color to a color of your choice by clicking on the  button. 

e. Change the font to a readable font of your choice. 

5. Now highlight cells A2-F2. 

a. Change the color of the fill to yellow by clicking on the  button. 

b. Change the font to 14. Bold it by clicking on the  button. 

6. Now highlight row 18. Right click and Insert. 

a. Highlight A19-F19. 

b. Change the color of the fill to red, the size to 14, and bold it.  

7. Now we need to copy and paste the information from sheet 2, for Burger King. 

a. Click on Sheet 2 at the bottom of your screen.  

b. Highlight cells a A1-F16. Copy it by pressing CTRL+C, pressing  from the home ribbon, 

or right click and choose Copy from the menu.  

c. Go back to Sheet 1. Place your cursor in cell A36. 

http://www.usd.edu/trio/tut/excel/index.html
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8. Now highlight cells A19-F19. Choose  from the home ribbon. 

a. Highlight cells A36-F36. You have now copied the format to the 

new cells.  

b. Change the fill color to blue. 

9. SORT. Highlight cells A3-F17.  

a. Go to the Data Ribbon. 

b. Click on the sort button. 

c. Pull down the sort by menu, and choose Calories from the list. 

d. Now highlight cells A20-F34. Sort this one by size. 

e. Highlight cells A37 ς F51. Sort this one alphabetically. 

10. Now highlight rows 4-17. Change the font to 8. Do the same for rows 

21-34, and rows 38-51. 

a. Double click between the A and B again to resize column A, 

now that the font is smaller. 

11. Highlight cells A3-F17. Click on the borders tab and choose All Borders. 

a. Do the same for cells A20-F34, and A38-F31. 

12. Highlight cells B3-F3.  

a. Right click and choose Format Cells. Click on 

the Alignment tab. Change the orientation to 

45 degrees. 

b. Do the same for cells B20-F20. 

c. And again for cells B37-F37. 

13. Now we are going to insert some pictures. Go to the 

internet, and to Google Images. In the Image search, 

ǘȅǇŜ άaŎ5ƻƴŀƭŘΩǎ [ƻƎƻΦέ  

a. Find a logo that is rather small. Click on it, then go to See Full Size Image. Right click and save 

this logo into your My Pictures folder.  

b. CƛƴŘ ŀ ƭƻƎƻ ŦƻǊ ²ŜƴŘȅΩǎ ŀƴŘ ŦƻǊ .ǳǊƎŜǊ YƛƴƎΦ 

c. Dƻ ōŀŎƪ ǘƻ ȅƻǳǊ ŀǎǎƛƎƴƳŜƴǘ ŀƴŘ ŎƭƛŎƪ ƻƴ LƴǎŜǊǘΣ ǘƘŜƴ tƛŎǘǳǊŜΦ CƛƴŘ ǘƘŜ aŎ5ƻƴŀƭŘΩǎ ƭƻƎƻΣ ŀƴŘ 

insert. Place it  roughly in column G. Do the same for the other three logos. 

14. Add a header. Go to the Insert ribbon, and choose Header. Type your name in the left column, and 

Assignment 1 in the middle column.  

a. Go to View, and choose Normal to get back to your original view. 

15. Check to make sure that your document is only 1 page long.  

a. Click on the Office button, go to print, and then print preview. Check the bottom of the page to 

see that it says page 1 of 1.  

b.  LŦ ƛǘ ƛǎƴΩǘΣ Ǝƻ ǘƻ tŀƎŜ [ŀȅƻǳǘΣ aŀǊƎƛƴǎΣ ŀƴŘ ŎƘŀƴƎŜ ǘƘŜ ƳŀǊƎƛƴǎ to Narrow. If it IS only one page, 

you are ready to print. 

16. Make sure you SAVE this document in MY DOCUMENTS. Then print it and turn it into the basket. 
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Computer Technology 

Assignment 3 
Microsoft Excel 2007 

 
1. Open Microsoft Excel. Choose Assignment 3 from the Spreadsheet file in Computer Technology. 

2. Now you will sort the gymnasts, first by county, then by name.  

a. Highlight cells A2-G23. Go to the Data ribbon, and choose sort. 

b. In the pull down menu next to Sort By, choose Country. 

c. Click Add level.  In the next 

pull down menu, choose 

name. 

d. Press ok. 

3. Highlight cells A2-H2.  

a. Go to the Home Ribbon and 

choose Wrap Text from the 

menu. 

b. Underline cells A2-H2. 

4. Highlight A3-A23. Right click and choose Format Cells.  

a. Click on the Alignment Tab. 

b. Click to put a check mark next to Shrink Text. 

i. Now the countries should all fit, without you having to widen the column. 

5. Highlight cells C3-H3. Click on the  button in the Home Ribbon. You now have a total for 

Jade Barbosa. 

a. Now try it again with Fei Chengôs scores.  

b. Once you have done it a few times, review using autofill. Highlight cell H4 and put your 

cursor on the lower right hand corner until it turns into a black plus sign. Drag down to row 

25. 

6. Now highlight cells C3-C24. Use the  button again to total the scores for uneven bars. Do 

the same for all the other events. 

7. Time to find the Average. You have to be careful because you do not want to calculate the Total 

into the average! 

a. Put your cursor in cell C25. Type Average= 

b. Then highlight cells C3-C23. NOT the total. You should get 16.179 as your answer. If you 

got a much higher number, that is because you calculated the total with it.  

c. Now do the same for each of the events. 

8. Formatting ï Highlight cells A24-H25. Change the background color by clicking on the  

button. 

a. Do the same for A2-H2.  

b. Highlight A1-H1. Click on the Merge & Center button.  

c. Change the font to 16 and choose a readable font of your choice. 

d. Highlight cells A1-H25. Change the borders to All borders. Then choose 

Thick Box border from the list. 

9. Add a header and print. Turn into the basket.   
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Computer Technology 

Assignment 4 
Microsoft Excel 2007 

 

1. Go to Computer Technology/Student Common/Computer 

Technology/Spreadsheets/Assignment 4. 

2. This is a list of Student Loans from Summer Ridge Community College. Make the following 

changes to the look of the sheet: 

a. Highlight A1-I1 and center across using the button. Do the same to 

A2-I2. Change the font size to 18 pts. Change the font to Times New Roman. 

b. Highlight A3-I3. Click on the  button. With the cells still highlighted, center 

 them. Then Underline. Change the shading to gray. 

3. Double click between the A and B to widen column A, so you can see all names. 

4. Now you will be changing the format of several of the columns.  

a. Highlight column B. Right click and choose Format Cells. On the Number tab, choose 

Special, and Social Security Number. 

b. Highlight column C. At this school, account numbers are formatted as ####-##. You will 

have to do a custom format.  

i. Go to Format, Cells, and choose Custom. In the Type box, type ####-## and press 

ok.  

c. Highlight column D. Press the  button to change the format to money. 

d. Highlight column E. Go to Format, Cells, and choose Date from the Category list. 

Choose 03/14/01 format. 

i. Double click between the E and the F to resize column E.  

ii.  Resize any other column that needs it. 

5. Now we will calculate the monthly payments required by each account, in the F column. 

a. Place your cursor in cell F4. The minimum due is determined by one payment every 12 

months for ten years. This is really TWO math problems, but it can be done in one 

formula as follows: 

i. Type the first problemðthe amount due divided by 10 years (which tells you how 

much they must pay EACH YEAR) into parenthesis. Then divide that by 12ðthe 

12 months of one year. It should look like this:  =(D4/10)/12. If you did it right, 

you should have a minimum payment due for Bethanne Arne of $165.54. 

b. Now you will calculate the interest for each payment and add it to your total. Again, this 

is TWO problems you will put in one formula. First, the amount due * the interest, and 

then that total added to the amount due. It should look like this: =(F4*G4)+F4. If you did 

it right, your answer should be $172.99. 

c. Now that youôve done the math,  you can use Auto Fill to pull down the answers to all the 
problems. 

6. Sort ï Currently the names are sorted b. We want to sort them by account number.  

a. Highlight cells A3-I31. Go to Data, Sort. Sort by Account number and press enter. 

Tabithah Garland should now be the first name on the list. 

7. Filter ï Now you will use a filter to answer the questions on the Questions Worksheet.  
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8. Highlight cells A3-I31 and click on Filter. Now there are pull down arrows on each row. 

a. Click on the Questions worksheet and answer the questions using your filter. 

b. When you are trying to find an answer, make sure you are filtering the right column. 

When you are finished, make sure you pull down the arrow again and choose ALL to 

show all listings again.  

c. To get these answers, you will be using Top Ten, Bottom Ten, and Custom a great deal. 

Make sure you test them out! 

9. When finished, add a header to both pages and print both. Staple them and turn in to the 

basket. 

Computer Technology 

Assignment 5 
Microsoft Excel 2007 

 
You are in charge of See-It-All Travelôs purchases. In a spreadsheet you keep a list of purchases and 

balances due. 

 

1. Key in the worksheet below. Be sure to add a Header with your name, period, and 

assignment number. 

2. Widen columns to accommodate all entries. 

3. In cell D3 key in the formula for Total Amount. The formula is:  

Purchase Amount * a tax of 1.06. 

4. Copy the formula in cell D3 down through D12. 

5. In cell F3 key in the formula for balance due by:   

adding purchase amount and total amount, minus the down payment. 

6. Highlight cells C3 to C12. Right click and format the cells to be correct date form. Align to 

the left.  

a. To format cells with date: Highlight cells to be formatted. Right click. Go to format cells. 

Choose the number tab, then click on date. Choose the proper format. 

7. Use auto sum in cells B13, D13, E13, and F13 to get totals. 

8. Highlight cells A3 through F12. Arrange in ascending order.  

9. Print Preview and print. Turn into the basket. 
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Computer Technology 

Assignment 6 
Microsoft Excel 2007 

 

You are a teacherôs aide at Elk Ridge Middle School. Your teacher has asked you to record grades for 

one of her classes. You are to list the assignments and test, compute the total points for each and 

calculate the percentage and assign the grade. 

 

1. Key in the worksheet below. Be sure to add a Header with your name, period, and 

assignment number. 

2. Add a first name for each of the last names given. After keying in the column headings and 

column A, add gridlines with the border key. 

3. Widen columns to accommodate all entries (do not cut off any information). Use auto sum to 

find the totals in column F.  

4. To find percent in cell G5, divide the total by the points possibleð180.  

a. Format column G to a percent by highlighting the cells and press the  button from the 

tool bar.  

5. Sort the students and all information about each A-Z. 

6. In cell B17, find the average by using the =AVERAGE( function. Enter the cells to be 

averaged between the parenthesis. Auto fill the formula across. 

a. Ex: AVERAGe=(B6-B15) 

7. In cell B18, find the maximum score by using =MAX(. Enter the cells to be maxed between 

the parenthesis. Donôt include the point totals in your cell range! 

8. In cell B19, find the minimum score by using =MIN(. Enter the cells to be min between the 

parenthesis.  

9. Format the document to look like the one below. Print preview, print, and turn into the 

basket. 
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Computer Technology 

Assignment 7 
Microsoft Excel 2007 

 

Open Microsoft Excel. Open Student Common and choose assignment 7. 

1. Type in the information from the in-class survey. If you were absent that day, use the 

information given below. 

2. Before making the charts, right click on the Assignment 6 tab. Choose Insert>Worksheet.  

3. Title the new worksheet ñGraphsò 

4. You will make four graphs for each survey, as indicated below: 

a. Birthdays ï Column 

i. Highlight cells A4-B15. Go to the Insert tab and choose Column 

from the list. Choose a style. 

ii.  In the data section of the Design tab, choose Switch Row/Column. 

iii.  In the Chart Layouts choose the center option.  

iv. Change your chart title to Birthdays.  

v. Highlight your graph and choose move chart from the toolbar. 

Select ñGraphsò from the pull down menu. Arrange the chart on the 

new sheet you created. 

b. Grades ï Line (if you donôt remember, guess!) 

i. Highlight cells D3-F15. Create a line chart. Follow the same steps 

you did for the Birthday chart, giving it a title and moving it to the 

graphs tab. 

c. Favorite Junk Foods ï Pie 

i. Highlight A22-B26. Follow the same steps, creating a column chart. 

d. General Survey ï Bar 

i. Highlight D19-G28. 

ii.  Follow the same steps, adding a title and moving to the graphs column. 

5. Print only the graphs page. Make sure 

all of them fit on one page using print 

preview. Add a header and print. 

 

 

 

If you are absent the day we do this in class, 

use the information 
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Computer Technology 

Assignment 8 
Microsoft Excel 2007 

 

Open Microsoft Excel. Open Student Common and choose assignment 8 

In this lesson you will create graphs based on the Soap Shop unit done in the 7th grade. Open up 
assignment 7. Here you will find the information from one of the recent Soap Shop Units.  

1. Center and merge the title across cells A1 ï H1, and A2-H2. 
2. Change the font and size of the title to what you choose, making sure the title is larger than 

the subtitle. 
3. Next, calculate the Profit Margin 

a. Profit margin is calculated by Price ς Production cost. In cell F5, calculate the profit 
margin using this formula. Use auto fill for each group. 

4. Now calculate the total profit. This is done by multiplying the Profit Margin by the amount 
sold. Use auto fill for each group. 

5. Now you will a column chart, to compare number of sales vs. profit. 7th graders learn that 
ƛǘΩǎ ƴƻǘ Ƨǳǎǘ ŀōƻǳǘ Ƙƻǿ Ƴŀƴȅ ōŀǊǎ ƻŦ ǎƻŀǇ ȅƻǳ ǎŜƭƭτƛǘΩǎ Ƙƻǿ ōƛƎ ȅƻǳǊ ǇǊƻŦƛǘ ƳŀǊƎƛƴ ǿŀǎΦ !ǎ 
you complete the rest of this assignment, make sure you answer the questions at the 
bottom of the worksheet. 

6. In column H, round the number in column G up, and then add two zeros. So, for Group 1, 

make 68.15 to be 7,000. 
7. Now to make a column chart. Highlight B4-B12. Then, holding down the CTRL key, 

highlight C4-C12, then H4-H12. Create 

a. Create a column chart. Make sure you DO NOT choose a 3-D column chart, just the flat 

one. 

b. Choose  the first option on the left for the chart layout. 

c. Title the graph Sales vs. Profit.  
8. bƻǿ ǿŜΩǊŜ ƎƻƛƴƎ ǘƻ ǘǳǊƴ ǘƘƛǎ ƛƴǘƻ ŀ combination chart. In your legend, click on 

Sales. Then click on it again to select it.  
a. Then right click on it to get a menu. 
b. Choose Format Data Series. Choose Secondary Axis from the list. 
c. With sales still highlighted, click on Change Chart Type in the upper left hand 

corner. 
i. Change the type to line and click ok. 

d. Now you have two chart types on one graph.  
9. Answer the questions at the bottom of the page, and position the chart so it fits on one 

page with the answers. Add a header, save,  print, and turn into the basket. 
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Computer Technology 

Assignment 9 
Microsoft Excel 2007 

 
Create graphs with the sets of information given. All information comes from actual sources.  You 

must organize it yourself in Excel and choose the graph that best describes that information. You 

will be graded on how easily you can read your chart. Questions are provided to help you know if 

your chart is readableðif you cannot read the information, rearrange your chart! 

Tips: 

 Sometimes you may want to change the SCALE of your chart.  

 Adding VALUES or PERCENTAGES to your chart can make it more readable 

 Labeling the X and Y axis is sometimes necessary. 

1. Michael Jordan PPG 

a. Create a chart that shows Michael Jordanôs PPG over the course of 15 years, beginning 
with 84-85, and ending with 99-00.  

b. Compare this to his overall average over the course of those 15 years.  

i. Hint: You will need to calculate his average before you make this chart. 

c. Here are his PPG from84-85 to 02-03: 28.2, 22.7, 37.1, 35.0, 32.5, 33.6, 31.5, 30.1, 32.6, 

26.9, 30.4, 29.6, 28.7, 22.9, 20.0  

i. How many years did Michael Jordan get above his average? 

ii.  What year did he score the least amount of points? 

iii.  What do you think the graph is trying to say? 

2. Nutritional Facts 

a. Using the information in Assignment 1, create a graph.  You may use the information in 

any way you wish. Decide what point you are trying to make, and then create a graph that 

shows what you want to say. 

b. Answer these questions below your graph: 

i. What is this graph trying to show? 

ii.  What is significant about the information in your graph? 

3. Civil War Data  

a. Go to http://www.civilwarhome.com/casualties.htm, or pull up the file in Student 

Common/Spreadsheets/Assignment 8 ï Civil War. 

b. Using the information in this article, create a graph. There are TONS of different angles 

you can take with thisðmake sure that your graph makes sense and is saying something! 

i. Extra Credit : Create a 4
th
 graph with actual information you find on the internet. 

Please include the resource (URL) where you found the statistics. 

 

http://www.civilwarhome.com/casualties.htm
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Computer Technology 

Assignment 10 
Microsoft Excel 2007 

 
Open Assignment 9 from Student Common/Computer Technology/Spreadsheets. 

 

1. Highlight cells A1-J1. Click on the  button on the home ribbon to wrap the text. Underline it 
and Bold it. Shade it with gray. 

2. Highlight row 1 and row 2. Right click, and choose Insert from the menu.  
a. You should now have two new rows! 
b. In Row 1, type Hair Dot Net 
c. Lƴ wƻǿ нΣ ǘȅǇŜ ǘƻŘŀȅΩǎ ŘŀǘŜΦ 

i. Right click on the date and go to format cells. 
ii. In the Number tab, click on date, and choose March 14, 2001 as the format. 

d. Use the  button to merge and center both rows, one at a time. 
e. Change the font to one of your choice for both rows. 
f. Change the font size in row 1 to 18. In row 2, change the size to 12. 

3. Highlight B4-B24. Right click, and choose Format Cells. 
a. Go to the alignment tab, and choose Shrink to Fit. 

4. Now go to D4. We want to find out what a 20% discount on the Original price is.  
a. Type =C4*.25 and press enter.  
b. You now know what 20% of 13.50 is. Now calculate Our Cost, by subtracting the discount 

from the original price: =C4-D4. 
5. Now we are going to markup our price by 50%--ǘƘŀǘΩǎ Ƙƻǿ ƳǳŎƘ ǿŜ ŎƘŀǊƎŜ ǘƘŜ ŎǳǎǘƻƳŜǊΦ 

a. In F4, you will find out what 50% of our cost is.  
b. Finding the percent of a number is on the final, so make sure you know how to do this!!! 
c. In G4, add our cost and the markup together, to get the customer cost. 

6. Now you know your customer cost. We need to charge them a tax of 6%. So this time, you will 
multiply the customer cost by 1.06.  

7. In column I is listed how many of each item were sold. We need to figure out our profit. 
a. In J4, multiply the amount sold by MARKUP, NOT by customer cost. 

8. bƻǿ ƭŜǘΩǎ ǎƻǊǘ ǘƘƛǎ ƭƛǎǘ ōȅ tǊƻŦƛǘΦ IƛƎƘƭƛƎƘǘ ŎŜƭƭǎ !п-J24.  
a. Go to Data, and sort it by Profit. 

9. In A25, type Totals. Then sum the totals for all the columns.  
a. Highlight the cells A25-J25 and change the shading to gray. 

10. Highlight cells A4-J25. Add All Borders to it. Then highlight cells A1-J25, and choose Thick Box Border 
from the list. 

11. Go to the Home Ribbon. Choose Orientation and then Landscape. 
12. Highlight rows 4-25 and change the font size to 10. 
13. tǊƛƴǘ ǇǊŜǾƛŜǿ ŀƴŘ ŜƴǎǳǊŜ ǘƘŀǘ ǘƘŜ ǿƘƻƭŜ ŘƻŎǳƳŜƴǘ Ŧƛǘǎ ƻƴ ƻƴŜ ǇŀƎŜΦ LŦ ƛǘ ŘƻŜǎƴΩǘΣ ǊŜǎƛȊŜ ǎƻƳŜ 

columns to make it fit. 
14. Add a header, Print, and turn into the basket. 
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Computer Technology 

Assignment 11 
Microsoft Excel 2007 

 
Open Assignment 11 from Student Common/Computer Technology/Spreadsheets. 

 

1. On the tab marked BMR Formula, you will be calculate your Body Mass Indexðthis will tell 

you how many calories a day you should be eating in order to maintain your weight. 

a. In cell B15, type your height IN INCHES. So, five feet is 60 inches, so if you are, say 5 

foot 6, then you are 66 inches tall. 

b. In cell B17, type your weight in pounds 

c. In cell C18, type your age. 

d. In cell C19, type your activity factor. This is a NUMBER , using the Activity Factor 

guide just below this. 

e. Again, make sure you type a number into this box, not words.

 
2. Now look at the colored boxes at the bottom. If you are male, your BMR is in the blue box. If 

you are female, it is in the red box.  

a. Go to the Food Chart tab, and type that number in cell B2.  

3. Now you will calculate your calories.  

a. Go onto the internet and to the website http://www.fitday.com 

b. Click on free web account. You will need to sign on to this website by entering your e-

mail address and your password. Donôt worryðyou wonôt get junk mail. If you donôt 

have an email account, create one in gmail or yahoo. When you have created a username 

and password, type them into cells C24 and C 25, in the boxes provided. This so you 

donôt forget them and can go back into your account tomorrow.  

i. SAVE THIS DOCUMENT RIGHT NOW IN MY DOCUMENTS. 

4. In Fitday you can enter what you eat each day and it will calculate the calories for you.  

i. You do not have to record what you have actually eaten. Instead, record a typical 

day for you.  

ii.  You will need to record 10 days. Once you have finished entering one day, click 

on  to enter the next. 

iii.  Make some days higher in calories than others. But try to stick to things you 

actually do eat in order to get a better picture of your health. 

iv. Make sure to adjust the AMOUNT of each item you enter, so that it is accurate. 

http://www.fitday.com/
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5. Go back to the food log in 

Excel. Enter consecutive dates 

in column A. Enter the calories 

you have calculated for the ten 

days in column B. Skip 

column C and D for now, and 

enter the percentage of Fats, 

Carbohydrates, and Protein that you ate each day. You can find these percentages near the 

pie chart on the website. 

6. You should now have your calories for each day entered. You are ready to figure out how 

much OVER or UNDER you are eating.  

7. In cell B2 enter your BMR. 

a. In cell C5 do the following formula: =B5-B2. 

i. Now, if you were to use autofill, you would not get the right answers. We need to 

turn B2 into an ABSOLUTE VALUE, so that when we use autofill, it does not 

change.  

ii.  Go back to cell C5 and change the formula to =B5-$B$2. Now when you use 

autofill, your math will be correct. 

iii.  This is subtracting your BMR from the number of calories you ate that day.  

b. In cell D5, do the following formula: =B5/$B$2. This is figuring a percentage deficit or 

surplus. Change the format on this column to %.  

c. Now you can see if you are eating too much or too little. If you would like to lose weight, 

you want your deficit to be somewhere between 20-30%, no more and no less. If you 

want to gain weight, you need to exceed your calories by at least 10%. 

8. Now look at your fat % column. All of the days where your percentage is higher than 30%, 

change the color to red.  

a. Regardless of how many calories you eat, if your fat percentage is consistently higher 

than 30% you are not eating healthy! 

9. Now letôs graph some of our results! We will be making two chartsðone to determine how 

we have done staying within our goal of calories, and the other to determine our total intake 

of fat, protein, and carbohydrates compared to what our intake SHOULD be.  

10. In the Food Chart tab, highlight the percentages for your fats, carbs, and proteins. This 

SHOULD be cells E5-G14 if you have 

ten days. 

a. Copy this, and click on the Graph 

Setup page. Paste it into cell A1.  

b. In cell D1, type ñFat Goalò, in E1, 
type ñCarb Goalò and in F1 type 

ñProtein Goalò.  

c. Then, in put in the percentage 

you SHOULD be eating of each 

nutrient, as shown. 

11. Highlight A1-F11, and create a Column Chart. Click on the far right option for Chart Layout.  

Change your chart title to Nutrient Intake . 

12. Now, you will change the chart type for some of the items. Looking at your legend, click on 

the row of columns that corresponds with your Fat Goal. Click on it. Then in the 
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left corner choose Change Chart Type. Change it to a line chart, without the dots.  

a. Do the same thing for Carb Goal and Protein Goal. 

b. Last, you are going to change the colors of your remaining bars to match their 

corresponding goal.  

i. In your legend, click on Fats, then 

right click. Change the color by right 

clicking and choosing a color from the 

bucket button. Pick the SAME 

COLOR that is being used for your 

fats goal. 

ii.  Do the same for your Carbs and Protein.  

c. Last, move the chart into the graphs tab by highlighting it and choosing Move 

Chart Location on the right side of the Chart Tools bar. 

13. Now you are ready for the second chart. Go back to your Food Chart Tab. 

14. Highlight the dates and the calories, cells A4-B14. Include the titles. Copy them into the 

Graphs Setup tab.  

a. In the next column over, type in your BMR for every day. Your amount of calories 

changes every day, but your BMR stays the same! 

b. Now create a line chart, and call it 

Calories Eaten. It should look like the 

example below.  

c. Move it to the Graphs tab. 

15. Add a Header to each page.  

16. Print Preview to make sure both of your 

graphs take up only one page. 

17. Print your Cover Sheet, Food Log, Graphs 

Setup, and Graphs page. 

Staple and turn in to the basket. 

 

 

 

 

Computer Technology 

Assignment 12 
Microsoft Excel 2007 

 
Open Assignment 12 from Student Common/Computer Technology/Spreadsheets. 

 

 

You have just gotten your first job after graduating from college.  You are single without children. You 

are making $35,000 a year.  

1. Open Excel and open Assignment 12. 

2. Fill in the Income section.  

a. Type your yearly wage in the space provided. 

b. Divide that by 12 months to get your Gross Income. 
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c. Multiply your gross income by .25% to calculate taxes. 

d. Multiply your gross income by .10% to calculate insurance 

and retirement. 

e. Subtract taxes and insurance from your gross income to 

calculate your net income per month. 

3. Fill in information for monthly expenses. 

 

 

Rent          Car 
 

Mansion  $4,000 per month  Sports car  $500 per month 

House   $1,200 per month  High-end car  $450 per month 

Townhouse  $1,000 per month  Middle-level car $300 per month 

Apartment  $600 per month  Low-end car  $200 per month 

Shared Apartment $250 per month  Clunker  $100 per month 

Live at home  Free    Bike   $10 per month 

Bus pass  $10 per month 

Groceries 
 

Full stock, no help from home,  $200.00   Extras 

  lots of food and treats      

Less food, no help from home,  $150.00  Jet Skis $300 per month 

  less treats.    Boat  $400 per month 

The bare minimum $100.00   Snowmobile $200 per month 

Live on parents (only if at home) $50.00  Horse  $900 per month 

 

Utilities ï Pay 30% of your house payment. Ex: =1200*.30 

Car Payment ï Pay 75% of your car payment. Ex: =300*.75 

Gas ï Pay 15% of your car payment. 

Entertainment ï You decide how much you would spend a month on movies, CDôs, etc. 

Student Loans ï You must pay a minimum of $50.00 a month. You may pay more if you choose. 

Credit Cards ï You have a balance of $1,000 on your credit card. You choose how much to pay per 

month. 

Savings ï This is optionalðyou choose how much to put in each month. 

 

4. Now do a six month budget of your expenses. You must have at least $100.00 left over at the 

end of each month. If you do not have $100 left over each month, change your expenses until 

you can afford it. 

5. In cell E18, sum all expenses by adding cells E6 to E17.  

6. In cell E19, subtract your expenses from your income. The remaining amount will 

automatically be added to next monthôs income. 

7. Add a header. Print Preview. Print and turn into the basket. 
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Computer Technology 

Assignment 13 
Microsoft Excel 2007 

 
 

For this assignment, you will be using a worksheet handed to you. If you need another copy, you can get 

it from Student Common/Computer Technology/Spreadsheets/Assignment 13. You will learn all about 

how to use a Loan Amortization chart to figure your monthly payments and interest for the purchase of 

large items. 

 

 

Computer Technology 

Assignment 14 
Microsoft Excel 2007 

 
1. Open a new workbook. Create the worksheet below.  

a. Make sure you widen each column to fit the text. 

b. Align the text in the columns to match the worksheet below. 

c. Center the title over the cells. 

d. Change the font on the title to a font of your choice. Change the size to 16. 

e. Compute the total for each person 

f. Compute the Team Average for each game. Do not average the Total column. 

g. Shade the Team Average row to light gray 

h. Format the Team Average for each game as Number with 1 decimal place. 

i. Insert a new column to the left of column B 

j. In cell B3 key : LAST NAME. 

Format this heading like the 

other headings. 

k. In cell A3 change the heading to: 

FIRST NAME 

l. Change the height of row 3 to 

48. 

m. Change the Font of row 3 to 10 

point bold 

2. Wrap the text in each cell of Row 3. 

3. Change the orientation of the text in row 3 to a 45 degree slant from left to right (use the 

alignment tab in Format Cells to do this.) 

4. Highlight A3 to F8 and choose All Borders 

a. Change the alignment in row 3 to center 

b. Beginning in cell B4 to B7, key the following: Simpson, Burns, Mann, Szyslak. 

c. Sort the worksheet alphabetically by Last Name. 

5. Create a Bar Chart for the information in cell B3 to E7.  

a. Title the chart Bowling Team Comparisons. 

b. Place your name as a subtitle below the title. 
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6. Now create a Pie Chart. 

a. Highlight the names of the players and the information for totals only. 

b. Create a 3-D pie chart. 

c. Choose a chart layout that will show the percentages. 

d. Title the chart Player Game Totals 

e. Make sure both graphs fit on one page.  

7. Add a header, print preview to ensure it fits on one page, and print. 

 

 

Computer Technology 

Assignment 15 
Microsoft Excel 2007 

 
Go to Computer Technology/Student Common/Computer Technology/Spreadsheets/Assignment 15. 

1. You see a list of students at a high school who owe fines. Do the following: 

a. Center the title and subtitle across the cells 

b. Change the font of the title to size 16, the subtitle to 12. Choose a readable and 

professional font. 

c. Center, Bold, and shade A3-G3. Now we are going to 

learn how to use Pivot Tables. 

2. Place your cursor anywhere in the list, and go to the Insert Ribbon. 

Click on the Pivot Table button. 

a. From the pull down menu, choose Pivot Table. 

b. You will get a menu that says Create PivotTable. You 

need to highlight the area where the data you need is.  

c. With the menu still on your screen, highlight cells A3-G56 

and press ok. 

3. Now you have a new worksheet that looks rather unusual.  

4. On the right side you have a Pivot Table Field List.  

a. This will seem confusing now, but as you work with the pivot 

table, it will begin to make more sense. 

5. Click and drag the following into the areas given. Or, you can right 

click on the field and choose from the list. Do them IN THIS ORDER, 

or it wonôt come out right. 

a. Class ï Row 

b. Name ï Row 

c. Teacher ï Page 

d. Gender ï Page 

e. Grade ï Page 

f. Fine ï Data 

g. Paid ï Column 

6. It should look like the picture to the left.  

a. Using the pull down errors, answer the 

questions on the questions tab of the 

assignment. After adding headers, print both 

pages and turn into the basket. 


